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ii CX1000e Color Label Press

Notices: The information in this document is subject to change without notice. NO WARRANTY OF ANY KIND IS MADE WITH REGARD 
TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. No liability is assumed for errors contained herein or for incidental or consequential damages in connection with the 
furnishing, performance, or use of this material. This document contains proprietary information that is protected by copyright. All rights are
reserved. No part of this document may be photocopied, reproduced, or translated into another language without prior written consent.

Trademark Acknowledgments: Windows is a registered trademark of Microsoft Corporation. All other trademarks are the property of their
respective owners.

Printing History
Edition 1.0, #240112 Copyright 2011, All rights reserved.
  
FCC Compliance Statement: This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this
device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause unde-
sired operation.

For Users in the United States: This product is intended to be supplied by a UL listed Direct Plug-In Power Supply marked „Class 2"or a UL 
listed ITE Power Supply marked „LPS“ with output rated 12VDC, 4.5A or higher. This equipment has been tested and found to comply with the
limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. In a domestic environment this product may cause radio interference, 
in which case the user may be required to take adequate measures. This equipment generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:
• Re-orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
Use of shielded cables is required to comply with the Class A limits of Part 15 of the FCC Rules. You are cautioned that any changes or 
modifications not expressly approved in this manual could void your authority to operate and/or obtain warranty service for this equipment.

For Users in Canada: This digital apparatus does not exceed the Class A limits for radio noise for digital apparatus set out on the Radio
Interference Regulations of the Canadian Department of Communications. Le present appareil numerique n'emet pas de bruits radioelectriques
depassant les limites applicables aux appareils numeriques de la class A prescrites dans le Reglement sur le brouillage radioelectrique edicte par
le ministere des Communications du Canada.

General Safety Information.
Note: Notes are used to notify of installation, operation, or maintenance information that is important but not safety related.
Caution: Caution  is used to indicate the presence of a hazard, which if ignored may result in damage to the unit.
Warning: Warning means that a potential safety hazard exists and indicates procedures that must be followed exactly to avoid serious personal injury.

Caution
You must use only 8.5 inch wide label stock in the CX1000e.  Failure to use specified label stock will result in damage to your printer and 
excessive build up of toner inside the printer.

WARNING!
TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THE UNIT TO RAIN OR MOISTURE. TO REDUCE THE RISK OF 
ELECTRIC SHOCK, DO NOT REMOVE EXTERIOR PANELS. NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO 
QUALIFIED SERVICE PERSONNEL. OPERATE THE UNIT WITH ONLY THE PROPER ELECTRICAL SPECIFICATIONS AS
LABELED ON THE PRINTER AND AC ADAPTER.

WARNING!
DO NOT WEAR LOOSE FITTING CLOTHING SUCH AS NECK TIES OR LOOSE LONG SLEEVES WHEN OPERATING THE
CX1000e. THE REWINDER MOTOR IS VERY POWERFUL AND THE ROLLER COULD CATCH THE CLOTHING WHILE THE ROLL
IS BEING REWOUND.

WARNING!
ALL LABEL STOCK MUST BE QUALIFIED FOR LASER PRINTING.  PLASTIC BASED STOCKS SUCH AS POLYPROPYLENE  OR
POLYESTER CAN MELT OR CATCH FIRE FROM THE EXTREME HEAT OF THE FUSER

!

!

!
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Introduction  1

Thank you for purchasing the CX1000e Color Label Printer.  The CX1000e Color Label Printer may
also be labeled as the CX1000e Color Label Press or as the Color Label Press in PTPrint software, the
status monitor software or the printer driver.  Hereafter in the manual the CX1000e Color Label
Printer will be referred to as the “CX1000e“.  The laser printer portion will be referred to as the 
“printer“.  The unwinder and rewinder unit will be referred to as the “base“.  Toner and label stock
will be referred to as “media“.

This manual is one of many sources of information for this product.  If you have problems or 
questions please consult one of these resources:

• Tech Support Phone: +49 (0)611 92777-0

• Tech Support Email:  support@primera.eu

• Online Knowledgebase: www.primera.com/kb

Important Note on Label Press Operating Environment! It is strongly recommended that the
CX1000e Color Label Press is operated in an air-conditioned, humidity controlled, smoke free, pet free 
environment. 

Section 1: Introduction
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2 Unpack and Assemble 

1. You will receive three boxes.  The printer portion of the CX1000e will be packaged inside a 
separate box on top of a pallet.  Set aside the printer box for now. Open the two remaining
boxes.  The following items will be included:   

Section 2: Unpack and Assemble

Figure 2-1.
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LOCTITE
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2. Remove all packing tape from the components.  There is one piece securing the dancer on the
unwinder and rewinder.  

3. Locate the left/unwinder chuck, the 3mm allen wrench, the Loctite and the unwinder. 
See Figure 2-2.

• The unwinder has a shorter dancer arm, dancer stops and two 6-pin ports on the back. 

• The unwinder chuck has a small stop disc attached to the back side of the chuck.  The

rewinder chuck does not have this disc attached. 

4. Assemble the Unwinder. See Figure 2.3. 
A. Partially remove the two set screws on

each chuck so that approximately ½
inch (1 cm) is exposed.  

B. Crack the top off the Loctite container
and place two drops on each set screw. 

C. Reset each screw until it is flush with
the outside of the chuck. 

D. Attach the chuck to the unwinder (left
side) drive shafts. Line up the holes in
the chuck with the flat edges on the
drive shaft. The holes must correspond
with the flats or the set screws will not
hold the chuck in place.

E. Tighten the set screws using the 3mm
allen wrench. Once they are tight,
attempt to rotate the chuck forward
backward while watching the drive
shaft. The drive shaft should move
with the chuck. If it does not move
with the chuck, loosen the set screws
slightly and turn the chuck until the
set screws are even with the flats. The
Loctite will dry in 24 hours.

Unpack and Assemble  3

Figure 2-2.
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4 Unpack and Assemble 

5. Locate the rewinder (right side) chuck, the label guide disc with the three interior holes, the
rewinder, the loctite and the 3mm allen wrench.  The rewinder has a longer dancer arm and no
6-pin ports on the back.   

6. Assemble the Rewinder. See Figure 2.5.
A. Partially remove the two set screws on the

chuck so that approximately ½ inch (1 cm)
is exposed.  

B.  Place two drops of loctite on each set
screw.

C.  Reset each screw until it is flush with the
outside of the chuck. 

D. Peel off the protective wrap from the label
guide disc. Attach the label guide disc to
the rewinder (right side) chuck using two
flat head bolts provided.

E. Attach the chuck to the rewinder (right
side) drive shafts. Line up the holes in the
chuck with the flat edges on the drive
shaft. The holes must correspond with the
flats or the set screws will not hold the
chuck in place.  

F. Tighten the set screws using the 3mm
allen wrench. Once they are tight, attempt
to rotate the chuck forward backward
while watching the drive shaft. The drive
shaft should move with the chuck. If it
does not move with the chuck, loosen the
set screws slightly and turn the chuck
until the set screws are even with the flats.
The Loctite will dry in 24 hours.

Figure 2-4.
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Unpack and Assemble  5

7. Locate the unwinder stand and printer stand.  Orient the printer stand so that the CX1000e logo
faces forward.  Attach the unwinder stand to the left side of the printer stand. Align the hooks
on the unwinder stand to the slots on the printer stand.

8. Locate the unwinder. It has the shorter dancer arm and two 6-pin ports on the back.  Attach it 
to the stand using the #2 Phillips screws and the washers found in the hardware bag. Use the
locator pegs on the stand and align them with the holes on the bottom of the unwinder. 

Locator Pegs

Figure 2-6.

Figure 2-7.



6 Unpack and Assemble 

9. Locate the rewinder stand.  Attach it to the right side of the printer base.  Align the hooks on the
rewinder stand to the slots on the printer stand.

10. Locate the rewinder.  The rewinder has a longer dancer arm and no 6-pin ports on the back.
Attach it to the stand using the #2 Phillips screws and the washers found in the hardware bag.
Use the locator pegs on the stand and align them with the holes on the bottom of the rewinder. 

Figure 2-9.

Locator Pegs

Figure 2-8.



Unpack and Assemble  7

11. Locate the printer box.  Remove the boxing material as shown in Figure 2.10 below.  The power
cord for the printer will be found in this packaging material.

12. Place the printer on the printer base.  Primera recommends three people to lift the printer on top
of the base. Two people are required to lift the printer and one person to guide the printer onto
the mounting pegs. Align the pegs on the base with the holes in the bottom of the printer.  Use
the locating label to align the  right front edge of the printer with indicated mark on the label.
The right front edge of the printer will be 1.5 inches (38 mm) from the front of the base. 

!! 48 Kg.
105 lbs.

Figure 2-10.

Figure 2-11.

1.5 inch (38 mm)

!!! 48 Kg.
105 lbs.



8 Unpack and Assemble 

13. Now that the printer is in place, all of the packing tape, clips and shipping protection devices
must be removed.  First remove the tape securing the front cover.

14. Open the front cover.  Remove the red toner cartridge stabilization clips. Remove all the print
cartridges.
a. Pull up slightly on the cartridge handhold.
b. Pull the cartridge straight out and use the handle to lift it off the guides.
c. Place the cartridges on a clean, flat surface out of direct light.

Figure 2-12.

Note: The CX1000e comes

with 4 starter cartridges.

These cartridges can only

be used with this printer!

Figure 2-13.



Unpack and Assemble  9

15. Remove the Image Transfer Unit (ITU) protection sheet.  Pull up on the plastic piece on 
the right side of the ITU to remove the sheet.   The protection sheet is attached to the 
plastic piece. 

Important Note: Do not touch the exposed ITU.

16.  Before replacing the toner cartridges remove the red plastic protection plate from the 
bottom of each toner cartridge.  Put cartridges back in to the printer. On each cartridge 
there are pegs that correspond to slide rails inside the printer. 

Note: Before replacing each cartridge, shake it side to side and front to back to redistribute 
the toner evenly.

Figure 2-14.

Figure 2-15.



10 Unpack and Assemble 

17. Close the front cover by first lifting the door to its maximum height, then disengaging the cover
prop latch, and then finally close the door until you hear a click from both sides of the door.  

18. Pull down to open the feeder door on the left side of the printer.  When the door is ¼ open pull
both latches toward the unwinder to release the latches on both side of the door to open it all
the way.  

19. Now connect one of the 6-pin round cables to the connector on the door.  

Figure 2-19.

Figure 2-17.

Figure 2-18.

2

1

3
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20. Connect the other end of this cable to the connector port on the right side or farthest away from
the printer. 

21. Connect the remaining 6-pin round cable to the back of the cutter mechanism and to the remain-
ing port on the unwinder closest to the printer.

Figure 2-20.

Cable

Figure 2-21.



12 Unpack and Assemble 

22. Locate the power converters and the printer power cord. Connect power to the printer and
switch on the power. Connect the power to the back of the rewinder and unwinder. Switch on
the power.

Figure 2-22.

ON

OFF

Unwinder
Rewinder

Printer



Unpack and Assemble  13

23. Attach five grounding straps in the locations shown below.  Screws and grounding straps are
found in the supply back. To attach the grounding straps you will need to remove and replace
the screws where indicated in the diagram below on the unwinder, rewinder and printer. The
grounding straps are not all the same.  Refer to the diagram below to determine the correct 
location of the straps.

Congratulations! Your CX1000e is setup!

Figure 2-23.

Important Note:
Match the location of your 6-pin

round cables to what is shown

in this diagram.  Notice how the

cables are crossed. 

To test for proper configuration

press the Stop/Cut button. If

you hear it cut, everything is

setup properly.

Note: Remove and

replace these screws

to attach grounding

straps.



14 Install Software

Three pieces of software will need to be installed in order to print to the CX1000e:

• The CX1000e Printer Driver. This software allows a networked or local computer to 
communicate with the CX1000e via the included Ethernet cable or Ethernet crossover cable.

• PTPrint. This software allows you to import an existing file and arrange it across a page (step
and repeat).  This software is a full-featured layout software that supports embedding or linking
many different files types.  It is not a design software.  Only one copy of the print software can
be used with each CX1000e.  This ensures proper supply level tracking.

• Status Monitor. This installs automatically along with PTPrint.  This allows you to estimate ink
costs for a particular label and accurately track toner and label stock supplies. 

1. To install the software place the CD in your CD-Rom Drive. The Installer application should
automatically launch in a few moments. If it does not automatically launch, follow these steps:

• Double-click the My Computer Icon, then double-click the icon of the appropriate CD drive
containing the Software Installer disc.

• Double-click setup.exe

2. Follow the prompts in the software installer to complete the installation of the software.

Note: If you connect your PC to the CX1000e using a yellow crossover cable it may be necessary to 
disable or modify the settings of your antivirus/firewall program.

Section 3: Install Software
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This section details the general process for installing label stock on the unwinder, and attaching the
label stock to the rewinder.  

1. Switch on the unwinder, printer and rewinder.

2. Place the label stock roll (max. 8“ OD) on the unwinder chuck.  Push the stock all the way back
until it touches the stop disc.    

Note: You must use only 8.5 inch wide label stock in the CX1000e. Failure to use specified label stock will
result in damage to your printer and excessive build up of toner and adhesive inside the printer.

Caution! You must use Primera approved label stock to avoid damage to your printer.  Damage due to use of
unapproved material will not be covered by the warranty.

Section 4: Load Label Stock

Figure 4-1.

Stop Disc

Figure 4-2.

ON

OFF

Unwinder
Rewinder

Printer



16 Load Label Stock

3. The loose stock should fall on the right side of the roll.  Turn the tension knob clockwise to
secure the roll to the chuck. Turn the knob as as tight as you can! Feed the stock under the
dancer arm and through the cutter.

4. Feed the stock under the dancer arm.

Figure 4-4.

Dancer Arm

Eyemark

facing up!

Figure 4-3.

Dancer Arm

Tension Knob

Note: To track supply roll

usage, remember to enter the

length of the roll using the

instructions in Section 6.4.

MP Feeder Door on Printer
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5. Continue feeding the stock over the roller and through the cutter.  Feed the stock throught the
cutter at an angle.

6. Continue feeding the stock into the printer feeder tray. Feed the stock under the sensor guard,
under the green guides and under the paper feed roller. Stop feeding when the leading edge of
the stock has covered the red stop block printed just outside the feeder door entrance.

Figure 4-5.

Feed Roller

Green Guides

Red Stop Block

Figure 4-6.

Sensor Guard
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7. Place an empty label core on the rewinder chuck.  Push the core all the way back until it touches
the back label guide disc.

8. Place the outer label guide disc on to the rewinder chuck. Push the guide until it touches the
rewinder core.  Turn the tension knob clockwise to secure the core and the label guide to the
chuck.  

Note: Some cores may be shorter than the the stock width. If so, make sure the distance between the label
guide discs is slightly larger than the stock width.

9. Print your label according to Section 5 of the manual. 

Note: Depending on when the printer was last used, the fuser will need to  heat up or cool down before
the printer will print.  This can take from 2 seconds to 2 minutes.

Figure 4-7.

Important Note: Use only

3“ I.D. Cores!

Figure 4-8.

Important Note: Make

sure the dancer arm is in

the up position before

you start your print.
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10. As the printer is preparing to print, get a piece of tape ready.  It is best to stand to the right side
of printer with your arms above the rewinder roll. As the stock is ejected from the printer, place
the tape on the middle of the end of the stock. 

11. Immediately after the label stock is attached, engage the Rewinder by flipping the Rewinder
Dancer Arm toward the printer until it touches the paper. 

Important! To minimize the slack loop that will be created under the rewinder, it is very important that you
lower the dancer arm immediately after the label stock is taped to the core.  

The taping process occurs very quickly so you may not get the label stock attached correctly the first
time you try it.  It is important to attach the label stock centered on the core. If the attached label
stock is too far to the right or left the paper may fold over itself and cause an uneven wrap.  If you
think the label stock was not attached properly, cancel the print job using the control panel on the
front of the printer.

Figure 4-9.

Dancer Arm

Figure 4-10.

Warning! Keep loose

fitting clothing such

as ties and shirt

sleeves away from

the rewinder once it

has been engaged.

!

Tape



20 Printing

PTPrint is the label layout software included with the CX1000e that will allow you to properly 
format images.  With this software and the layout wizard you can easily import a variety of file 
formats, step and repeat them across a page to correspond with your pre-diecut label stock and
print them to the CX1000e.

5.1 Array Images with PTPrint Wizard

1. To open PTPrint go to Start - All Programs - PTPrint folder - PTPrint or click the PTPrint icon on
your desktop.

2. The print layout wizard will appear. Click the Browse button to find the label you want to print.
The following formats are supported via the print layout wizard: BMP, EPS, JPG, GIF, PCX,
PNG, TIFF. See Section 5.4 for image formatting tips.

3. Once the graphic has been selected the size and dpi will automatically appear in the fields
below. The graphic should be 300 dpi or greater to achieve the best quality. Resolutions above
300 dpi are not necessary and only serve to increase the file size. Adjust the label size as 
necessary. By default, aspect ratio will be maintained. The DPI will be increased if you decrease
the size of the label.

4. Make sure “Using Pre-diecut stock“ has been checked.

Section 5: Printing 
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Design Tip! Design your label with the .125“ bleed included.  This will increase the size of your
graphic.  For example, if you want your final label to be 3“ x 4“, design your label to be 3.125“ x
4.125“.  Adding a bleed is NOT the same as increasing the size of your image.  Typically you 
would add a bleed to an image by doubling the size of the border around the image in your design
program.

5. Find the stock sticker attached to every roll of pre-diecut label stock.

6. Match the values on the stock sticker with the corresponding values in the setup wizard.

Cut Position

No Bleed With Bleed

x2



22 Printing

7. Once you have chosen the imported graphic and the Step & Repeat columns are set, click OK to
view the layout.

8. Save the File.  Go to File - Save. 

9. Click File - Print. 



Printing  23

10. Set the number of copies to correspond with the number of labels you wish to print.  Click OK.

Note: Depending on the status of your supplies you may see low supplies warning. Please see Section 6
for a guide to Toner Monitoring and Supplies Management. 

Saving PTPrint files. To save your PTPrint file go to the File Menu- Save.  The file will save with 
an CDL extension.  By default, imported graphic files will not be embedded in your PTPrint file.
Instead they are linked.  This means that PTPrint stores a path to the graphic file instead of the actu-
al file.  In order to maintain the integrity of the PTPrint file you can not move the location of the
imported graphic file.  For this reason it is recommended that all graphic files imported into PTPrint
are stored in the same folder as the PTPrint file. Alternately, you may choose Save Embedded File...
to embed the graphics within the CDL file.  
Supported Formats. The following formats are supported via the print layout wizard: BMP, EPS,
JPG, GIF, PCX, PNG, TIFF.  Primera recommends EPS files for the best quality.  If your image 
is not in one of these formats, it can be easily converted to one of the supported formats using
graphics programs such as Adobe Photoshop®, Illustrator® or Corel Draw®. See Section 5.5 for more
information.

Printing Over the Network. If your computer is not close to the CX1000e, you can still print to it
without fearing that you may not reach the printer in time to attach label stock to the rewinder.
Follow this procedure.

1. Unload the label stock from the feed tray.

2. Send the print job. 

3. When you reach the printer, load the label stock like you normally would using the instructions
in Section 4.  

4. The print will automatically begin when the printer senses the paper is present.

Important Note! If you would like to
predict toner usage for this job, print a
1 page proof print first. See Section 6.2
for more information. A one page print
will use approximately 10 feet 
(3 meters) of label stock.
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5.2 Adjusting Print Offsets

Use the following table to diagnose print offset problems. Before adjusting any offsets make sure
you have entered the correct label size, vertical spacing, and horizontal spacing in the PTPrint label
setup wizard. Offsets can be adjusted on the options tab of the status monitor.  Only vertical offsets
can be adjusted while the printer is printing!

Front of Printer

Feed Direction

Cut (Black Line)

Printed Image with

Bleed (Gray Area)

Problem:

Image is offset to the left or right.

Solution:

Adjust Vertical Offset.  Measure the offset

amount accounting for the bleed.  Adjust

in the direction indicated using the offset

adjustments on the options tab of the

Status Monitor.

+          - 

.........
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Problem:

Image is offset both front or back and left

or right.

Solution:

Adjust Horizontal and Vertical Offset.

Measure the offset amount accounting 

for the bleed.  Adjust in the direction 

indicated using the offset adjustments on

the options tab of the Status Monitor.

Problem:

Image is too short/narrow or tall/wide for

the cut.

Solution:

The image size may not be set correctly in

PTPrint.

Problem:

Images lines up with cut  on the

right side of the page but gets

gradually worse as it moves left.

Solution 1:

Printer Stretch Calibration is

required.  See Section 9.4.

Solution 2:

Image size may not be set 

correctly in PTPrint.

Problem:

Image is offset to the back or front.

Solution:

Adjust Horizontal Offset.  Measure

the offset amount accounting for

the bleed.  Adjust in the direction

indicated using the offset adjust-

ments on the options tab of the

Status Monitor.

-

+
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5.3 Manually Array Images using PTPrint

In some cases it may be necessary to manually import images without using the label setup wizard.
For example, if you wish to arrange multiple different labels on the same page, you will need to 
follow this procedure. Follow the steps below:

1. Open PTPrint. Click the Cancel button to cancel out of the wizard.

2. Go to the File Menu - Choose Link. Browse to the location of the image. Click OK. 

Note: Linking creates a pointer to the image whereever it may be on your hard drive or network. 

3. The image you choose will be placed on the page.

4. Position Image. Once you have your image on the page you can fine tune its positioning using
the tool bar at the top of the screen. First select the object/image you want to move by clicking
on it. Now adjust the X and Y values to position the image. Adjusting the Y value will move
your image vertically up and down on the page. Adjusting the X value will adjust your image
horizontally side to side on the page. It might be easier if you adjust the anchor point of the XY
values to the top left corner of your image. This way if you set your Y value to zero you will
know that the image will be placed at the very top of the page. You may also use this area to
adjust the size of your image.

Note: Be sure to place the image only on the printable area of the page which is .125“ (1/8“) from either
side. Also be sure to leave room for your eyemark.

Note: To rotate an image go to the Layout menu - Choose Size/Move - Rotate

5. Repeat steps 2-4 to position each different label that you would like to on the page. To align
labels with one another or create consistent gaps between labels you can use the X and Y values
along with the size of the object to calculate the next position of the image. For example if the
first image is at X = 0.253 and Y = 0.0 and you wanted another image placed to the right of it,
aligned to the top with 1/8 gap, you would first follow steps 2-3 to rough position the image.
Now, change the X value to 3.378 and the Y value to 0.0. To get 3.378 add the original X value +
the width of the current label + the gap. (0.253 + 3 + 0.125). This procedure is only necessary if
you have two different labels. Follow step 7 below to array a single image or multiple images
on the page with consistent gaps.

Note: To align and distribute spacing between images go to the Layout Menu - Choose Arrange and
Distribute. Here you can align all selected objects to the bottom and set equal spacing between the labels.
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6. Array (Step and Repeat) images on a page. Before you begin this procedure align the image or
objects to the bottom left of the page, instead of the top left. This is necessary because the array
anchor point is set to the bottom left. It builds the array to the right and up from that object. 

First, select the image/objects you would like to array. Go to the Layout Menu - Choose Array. 
Set the following options on the tool bar that appears. You will always want to choose „grid“ for
the array type. Set the gap between the labels. The number of rows (Y) and columns (X) will be
limited by the maximum default page size of 8.5“ x 13.9“. You will not be able to increase rows and
columns beyond these boundaries. Click Close to set array. 

If all labels are not exactly positioned at this point, don't worry. You can always adjust the 
position of all the objects together using the instructions in step 4. Instead of selecting one image,
draw a box around all of them. Now you will be able to move all of them together and maintain
the interior gaps. 

7. Set the Page Size. Once all the labels are arranged on the page you can set the page size. The page
height should be the same as the total height measurement of all labels on the page. Before you set
the page size make sure the labels are oriented to the top of the current page. Select all objects by
drawing a box around them. Now set the Y value to zero on the tool bar at the top of the screen.
You can determine the page height by checking the height value on this tool bar. See below:
To set the page size go to the Layout Menu - Select Blank Size. Set the Height to the same 
measurement as the height of all labels combined.

Important Note: By default, the printer will place a minimum 1/8 inch (.125 in. 3.175 mm) between each
page.  If you would like to match the gap between the pages with the gap between the labels, you need to add
additional space onto the end of your page.  For example, if the space between your labels was .25 inches, you
would need to add .125 inches on to the end of your page.
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8. Print your job.  Click File - Print.  Set the number of copies to correspond with the number of labels
you wish to print.  Click OK.

5.4 Using Barcodes

The CX1000e will print barcodes in one of two ways.

A. Link to an EPS file with an embedded barcode. This will print the barcode in pure black if that is
the way it has been specified in the image. 

B. Link to a graphic with a blank space for the barcode.  Add the barcode directly through PTPrint.
Follow these instructions:

1. Array your image with the blank space for the barcode using the instructions in Section 5.1 
or 5.2.  

2. Add a barcode by clicking the shapes button on the left side tool bar.  Click the Barcode button.

Note: The labels shown in

parentheses on the print

screen will not be accurate

when manually arraying

images.  You will need to

multiply the number of

pages by the number of

images on the page.  
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3. A barcode toolbar will appear at the top of the screen.  Here you can enter your barcode
type and the value.   Click Apply when you are ready to insert the barcode.

4. A cursor will appear.  Place the cursor where you would like to insert your barcode and
click once.  You can make any adjustments to the position once the barcode is in place. 

5. Repeat the procedure for each image on the page.

5.5 Recommended Image Format for Imported Graphics

For the best quality prints, files should be imported in the following format:

1. EPS format (Encapsulated Post Script). Saving to EPS format is possible with such programs as
Adobe Illustrator and Corel Draw by using the File - Save As command. Use all the program
default settings for the EPS format except those specifically mentioned below. 

2. Save with fonts embedded. Saving to EPS format with fonts embedded is possible with such 
programs as Adobe Illustrator and Corel Draw by using the File - Save As command. Before
saving a window will appear which will give you this option. 

3. Resolution = 300 dpi or vector based. If the label design was entirely designed in Adobe
Illustrator, dpi does not apply because it will be vector based. If portions of the design (such as
photographs) were imported make sure the image you are importing is at least 300 dpi.

4. Save in CMYK color mode. Setting the color space should be done before you begin designing
or picking colors. However, it can be changed at any time before you save as EPS. 

5. The page size of the file should match the image size. In other words all, proof information
should be removed from the document. PTPrint only needs the image itself. This is referred to
as the Artboard in Adobe Illustrator.
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The status monitor will start automatically when you print a label for the first time.  You may also
start it manually by going to Start - All Programs - PTPrint - Status Monitor.  The status monitor can
be used for the following tasks.

• Monitor Toner Status

• Monitor Label Supplies

• Estimate Cost Per Label

• Track Used Toner Usage Levels

• Print Supplies Sheets

To navigate to the various functions of the Status monitor click on the menu items on the left.     

6.1 Estimating Cost Per Label (Quote Tool)

Using the quote tool inside the status monitor software it is possible to estimate the cost per label
before actually running job.  Use the following procedure to estimate cost per label.

1. Setup the label using the instructions in Section 5 of this manual.

2. Print one page of the label job you intend to print.  This is extremely important. The quote
tool is based on the last label printed and is most accurate if the label was printed as a one page 
print.  

3. Open the Status Monitor. (It automatically opens after you print.)

Section 6: Toner Monitoring and Supplies Management 
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4. Click the Quote Tool Tab (fourth tab down with the coin icon).  Your total cost per label includ-
ing stock will be displayed based on default toner cartridge and stock costs.  Adjust these values
to reflect the actual cost of your toner and label stock.

Once you set the stock and toner cost values you will not have to change them again unless you
make another purchase of stock or toner at a different cost.

Important Note: This tool provides a Cost ESTIMATE.  Actual costs may vary.

Labels Per Page

Always verify the labels per page is accurate. Adjust if necessary. If you manually array images on a
page in PTPrint using the instructions in Section 5.2, the Labels Per Page will have to be manually
entered.

Print or Save Quote

You can print this screen and attach it to the proof print and/or Save the screen capture as a JPG to
keep with the original PTPrint file.  Simply click the Print button or the Save button. 

6.2 Printing a Proof Print

Immediately before you print any job you can print one page of that job (Proof Print). If you print a
proof print you can:

• estimate cost per label
• enable analysis of available toner in cartridges vs. required toner to finish the job  

Even if you have previously printed a one page proof print to estimate label cost you must always
print a one page job immediately before your job to check if there will be enough toner for your job.
See the flow chart below for a typical work flow.

Print
Proof Print Required 

if First Time 
Printing Label

 
 

Subsequent Print 

Sufficient Media Job Finishes

Insufficient Media Print Reduced
Amount

Continue Printing 
with current media

1. Cancel Job
2. Print Supplies Sheet

Job Finishes
(Reduced Amount)

Job Stops after 
media depletion

Job Finishes1. Replace low media
2. Print Again

Note: To require a proof print before

printing set the „Enable Proof Print“

box on the settings tab (third tab

down).
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How do I Print a Proof Print?   A proof print is simply a one page print job using the same PTPrint
file that you created using the instructions in Section 5.  Go to File - Print.  Set your number of
copies to 1.  Click OK.  

It is not necessary to tape the proof print to the rewinder.  The proof print will use approximately 10
feet (3 meters) of label stock.  The stock will be automatically cut.   

What happens if I don't print a Proof Print?  If you do not print a proof print and you have
“Require Proof Print“ checked in settings, a notice will appear informing you that a one page job
will be sent to the printer instead of your original job. If you do not have “require proof print“
enabled, and you do not print a proof print you will not be warned if you do not have enough toner
to finish the job.

6.3 Managing Used Toner Cartridges

If the printer runs out of toner, the job will be stopped and the paper will be cut.   The printer can
not pause a job while you swap out toner because of calibration issues and physical issues with the
image transfer unit and the fuser.  Because of this, it is important to make sure you have enough
toner in all of the cartridges to finish your job.  Printing a proof print before a job allows you to
check if you will have enough toner to finish your job. See Section 6.2.

In many cases, a job will use only part of the toner in a cartridge.  For example, if a particular job
uses 75% of the toner in a
cartridge that leaves you
with 25% remaining.  If
the next job requires 50%
of that particular color you
can not use that cartridge.
The 25% cartridge will
have to be removed.
However, you don't need
to waste this cartridge.
You can write the remain-
ing toner amount on the
cartridge before you
remove it.  

You may also print a Supplies Sheet before removing the cartridge. This summary includes the 
percentage remaining in each cartridge and the Serial Number of that cartridge. You can then attach
this information to the cartridge you are removing.  In a few weeks if you have a job that needs less
than 25% of that color you can pull this cartridge from your library and put it in the printer. This
means that you can keep a library of partially used toner cartridges with varying amounts of toner
left.  This allows you to use as much toner as possible with out running out of toner in the middle
of a job.  See the diagram below for an example of how this works.

K 
75% 

K 
48% 

K 
27% 

M 
21% 

M 
56% 

M 
72% 

M 
12% 

C 
22% 

C 
45% 

Y
15%

Y
34%

Y
44%

Y
45%

C 
67% 

   C 
100% 

M 
34% 

   Y 
100% 

K 
45% 

Job Requires Toner Cartridge with at least 50% Magenta and at least 70% Black
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How to use a Toner Library 

1. Based on the proof print, before your job is sent to the printer the software estimates the
amount of toner required from each cartridge to finish the job.  It then checks this amount
against the cartridges in the printer.  If any of the levels are too low to complete the job, a 
warning message will be displayed.  Not only does this warning display cartridges that need to
be replaced to finish the job, it also displays the amount of toner required from each cartridge.
For example, if the cyan cartridge has 100% remaining but only 25% is required to finish the job,
you have the option to also replace this cartridge with one from your cartridge library that has
toner levels closer to the amount required to finish the job.

2. To find the appropriate cartridge for a job you can search your library.  We recommend you 
designate an enclosed cabinet near the printer as the used cartridge library and then attach a
supplies sheet to each cartridge as you remove it.  If you forget to place the supplies sheet on
the cartridge you can still identify it by referencing the old cartridge tab and finding the Serial
Number of the cartridge you want to use.  A unique serial number is printed on each cartridge.
Note: Old cartridges with no toner remaining can be deleted from the list by selecting the entry 
and clicking delete.

6.4 Enter Supply Roll Length

Each time you load a new roll of label
stock, enter the total length of that roll by
clicking the  icon in the bottom right side
of the status window.  The status monitor
will then subtract from this value as you
use the roll.  Before you remove a partial
roll print a supplies sheet using the
instructions in Section 6.3.

6.5 Low Supplies Warning

After you print a proof print and you send your job including the total number of labels you wish
to print, you may be prompted with a low supplies warning.

You will receive this warning if there is insufficient toner in any one of the four toner cartridges or if
there is insufficient label stock on the supply roll.  This calculation is based on the proof print that
you must print before each job. The warning displays which cartridges are low on toner for this job
and the percentage of toner from each cartridge that is required. You have several options at this
point.
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Print Reduced Amount. If you choose to print a reduced amount the CX1000e will print only the
amount that it is able to based on the current supply levels.  For example, if the job calls for 1500
labels but the cyan toner cartridge only had enough toner for 1200 labels and the supply roll only
had enough paper for 900 prints, the software would give you the option to print only 900 labels.  
The software will always calculate the reduced amount based on the lowest label value.

Print Original Amount. Choosing this option allows you to ignore the warning and print anyway.
Only choose this option if you simply forgot to update the Supply Roll Length value when you put
on a new roll or if the specified low toner cartridge is only a few labels short of finishing the job.
For example, if your job called for 1500 labels and the magenta toner only had sufficient toner for
1495 labels, you might decide to ignore the warning. 

Cancel. Choose this option if you want to replace the toner or supply label stock with a new/used
cartridge or roll that had sufficient toner or paper length.  Before removing the label stock or toner
cartridge, print a Supplies Sheet using the instructions in Section 6.5.  Put the appropriate label on
the low toner cartridge or label stock that you will remove from the printer.    

6.6 Other Functions of the Status Monitor

Click the options button to:
• change language
• change measure units (affects remaining stock value)
• edit fuser temperature (use to fix toner adhesion problems)
• change the vertical offset
• enable Require Proof Print (See Section 6.2)
• run a Stretch Callibration
• set Page Length (for use with BatchPrint software)

Click the support button
to view support contact
info and generate a tech
support report.  The tech
support report will gather
all of the log files associ-
ated with the CX1000e
and place them in a zip
file on the desktop.
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You must print on media sold by Primera or approved by Primera.  Check our website, call our sales
number or call your local dealer to purchase Primera media. 

• http://www.primeralabel.eu
• Sales Phone: +49 (0)611 92777 0

Please search for article 366122 on the Primera Knowledgebase for an updated list of compatible
stocks.  http://www.primera.com/kb 

All stock must be converted to 8.5“ width roll with 8“ outer diameter on a 3“ ID core. 

If you would like to have your media approved, please contact tech support.  They will arrange for
the media to be tested.  

Approved media will have the following properties:. 

Paper Type

The CX1000e can only print on Laser Printer approved materials with “low ooze“ adhesive. The
label manufacturer’s specifications will always say whether material is laser approved. If it does not
say laser approved it probably is not laser-approved. Be sure that the laser approval applies to the
face stock material, the adhesive and the liner. Stocks must be laser approved because the fuser
roller contacts the paper at 356 °F/180 °C. At this temperature facestock or liner material could melt
or burn. Adhesive that does not have low ooze properties will cause adhesive build up on the ITU
and fuser causing irreparable damage to both of these components.

Do NOT attempt to print onto non laser-approved materials. Damage to your printer may result
which will not be covered under your limited warranty. POLYPROPYLENE AND SOME OTHER
SYNTHETIC MATERIALS WILL MELT. Do not ever attempt to print onto polypropylene or any
other similar low-temp substrates.

Polyester and Paper generally will perform well in the CX1000e. 

Thickness

Mil = 2 - 6
Caliper (Inches) = .002 - .006
Millimeters = .0508 - .15
Grams/sq meter = 34 - 116 

Paper stock in the above range will feed through the CX1000e printer without problems. Depending
upon operating environment, Polyester stocks in this range will also feed through the printer 
without problems. However, 2-3 mil Polyester does curl as it exits the printer. In more humid 
environments this curling becomes more severe and could cause the paper to jam before it enters the
fuser. Stock thicker than 6 mill will intermittently jam before entering the fuser. This can be solved
by attaching a thinner leader material to the thicker stock. 

Section 7: Media Recommendations 

http://www.primeralabel.eu
http://www.primera.com/kb
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When testing other media consider the following additional criteria: 

1 Print Quality/Poor Transfer - See Note 1.

2. Color Accuracy

3. Solid Color Saturation

4. Label Feed (Requires minimum 100 feet of test paper)

5. Label Wrap

6. Fuser Heat Tolerance - wrinkling, bubbling, burning, breaking, curling

7. Water Tolerance

8. Scratch Tolerance

9. Effect of Adhesive in Printer (Requires minimum of 500 feet of test paper.) 

Note 1: Test at least 500 feet of continuous material before determining compatibility. Some plastic stocks
will initially appear to be compatible. However over time, the material absorbs too much heat so that not
enough is left over to fuse the toner to the surface of the material.
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Remove the print cartridge(s).
a. Pull up slightly on the cartridge handhold.
b. Pull the cartridge straight out and use the handle to lift it off the guides.
c. Place the cartridges on a clean, flat surface out of direct light.

Before replacing the toner cartridges, shake the cartridges side to side and back to front to 
redistribute toner.  Next, remove the protective sheet from the bottom of each toner cartridge.  
Put cartridge(s) back into the printer being sure to match the color label on the cartridge with the
one on the printer. On each cartridge there are pegs that correspond to slide rails inside the printer.

Section 8: Replace Toner Cartridges 

Figure 8-1.

Figure 8-2.
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9.1 Matching Pantone Colors

Important Note: PANTONE® to CMYK Bridge documents/files are available on the installation disc 
in the Pantone Folder.  These documents/files allow you to look up a Pantone Color number and find the 
corresponding CMYK value to use in the file that will be printed on the CX1000e.  See below for more 
explantation.

The CX1000e is a CMYK printer. This means any PANTONE® colors must be approximated using
CMYK color values. Most PANTONE colors can be approximated quite accurately using these
CMYK color values. Custom CMYK data has been developed for 1,137 colors from the PANTONE
solid coated color library of the PANTONE MATCHING SYSTEM® for the optimal reproduction 
on the CX1000e.  Under the Pantone folder on your installation disc you will find the following 
folders/files to assist with this process:

1. Calibrated Look-up Table\CX1000_Pantone_Swatches.pdf - This document is a full color PDF
with over 1000 swatches of color.  Below each color is the CMYK value and the corresponding
Pantone Color number. 

2. Look Up Table Text\CX1000 Pantone.pdf  - This is a text only (no swatches) version of the 
document described above.

3. Application Support Files - This folder contains other folders for various application-specific,
ready-to-use palette files for a number of Macintosh and Windows® applications. The files 
provided have been organized and formatted for Macintosh and Windows operating systems.
Each of these folders contains a collection of platform and application specific visually 
calibrated palettes. There are folders by product name or software publisher to help you locate
the particular file you are seeking. These files allow you to match CMYK values to Pantone 
values through the software program.  This is an automatic method of doing exactly the same
manual matching procedure described in 1 and 2 above.  Refer to your specific design program
manual for instructions on importing these palettes.

Note: The white brightness factor and other properties of the label stock used can affect the output of color.

Instructions for matching Pantone

While the CX1000e utilizes a Pantone calibrated printer it is not capable of reproducing all Pantone
colors like a flexo press. Instead it is a CMYK digital laser press. As with any CMYK printer it is not
possible to produce exact Pantone colors. However it is possible to approximate the Pantone colors
using specific CMYK color values. The color values must be used when the labels are being
designed. It is not possible to match Pantone colors when printing to the CX1000e using the same
image file that was used for another printer. To match Pantone colors the image file must be
designed specifically for the the CX1000e.

Once you have decided on the specific Pantone color you are going to match, record the Pantone
number. Now open the CX1000_Pantone_Swatches.pdf or the reference table, find the Pantone 
number and the corresponding CMYK value. Use that value for this Pantone color in your design
program. 

For example, if you intend to match Pantone 274C find that color in the reference table or the
CX1000_Pantone_Swatches.pdf . The resulting value would be C:95 M:100 Y:0 K:13

Note: The CMYK values in the CX1000e Pantone Palette are not the same CMYK values in the Pantone
Color Bridge book purchased from Pantone.

Section 9: Maintenance and Troubleshooting
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Recommended Design Procedures

Before beginning design work on a particular label the designer should have a specific printing
process in mind. This means that the designer will need to create a separate image file for each print
process. For example, you can not use the same image file for the CX1000e that you use on a flexo
press and expect the colors to print correctly. The designer will need to design a label specifically
for the CX1000e. This allows them to tailor the design to the specific attributes of the CX1000e. In
addition to the design aspect of the label, the designer should also pay close attention to color. If the
designer is designing a company logo that will be printed using many different types of printing
processes, some of which are capable of matching Pantone and some which are not, they should
choose a Pantone color that can be very closely approximated on a CMYK printer. To pick a good
cross process color consult a Pantone Color Bridge book and the CX1000e Pantone Palette above. To
get the most accurate approximation of a particular Pantone color the CX1000e Pantone Palette
should be printed on the CX1000e. See the instructions below.

If colors other than Pantone are desired there is another method for determining the proper CMYK
values to acheive the desired color output. The CX1000e is actually capable of printing many more
colors than are in the Pantone library. 4.2 Billion to be exact. Primera recommends printing CMYK
color increment swatches. This will be the best reference point for choosing the colors for a particu-
lar design. You can print the swatches on the various substrates that you will be using with the
CX1000e. (See instructions below for printing these swatches) CMYK color values are printed along
with the swatches so if you like a particular color you can get that exact color by using the CMYK
value associated with it in your design.

Matching Another Printer

Using the CMYK color increment swatches it also possible to very closely match the printed output
of the CX1000e with other printers. Simply compare the printed output of the other printer with the
printed CMYK color increment swatches printed on the desired substrate. Choose the color (CMYK
color values) that most closely match the other printer. 

Print the CX1000e Pantone Palette

1. Switch off the printer. Turn it back on. Wait for it to start up.

2. On the CX1000e Control Panel, change the MP Feeder paper type to Letter. Paper Menu - Paper
Size/Type - MP Feeder Size/Type - Choose “Letter“ - Then choose “Custom Type 5“. You may
have to press the down arrow repeatedly to view all the options on a particular menu.

3. Open the CX1000e Pantone Palette.pdf.

4. Go to File- Print - Choose the Color Label Press.

Note: Be sure to switch the Size/Type back to Universal/Custom Type 5 via the Control Panel before sending
another print job.

Print CMYK Color  Increment Swatches

1. Switch off the printer. Turn it back on. Wait for it to start up.

2. On the CX1000e Control Panel, change the MP Feeder paper type to Letter. Paper Menu - Paper
Size/Type - MP Feeder Size/Type - Choose “Letter“ - Then choose “Custom Type 5“. You may
have to press the down arrow repeatedly to view all the options on a particular menu.

3. On the control Panel also change the Default Source to MP Feeder.  Paper Menu - Default Source
- MP Feeder.

4. Open any internet browser.
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5. Type the printers IP address in the address bar. To find the printer’s IP address, navigate the
printer's control panel - Network/Ports - TCP/IP - Address.

6. A printer settings page will appear. Go to the Configuration Menu.

7. Click on “Color Samples“

8. Choose “Off CMYK“ or “US CMYK". These choices correspond to color matching settings 
available in the printer driver.

9. Click Print.

Not all colors will be printed on this job.  To focus in more on specific colors you can click the
Detailed Samples button on the color samples screen.  This will allow you to enter specific CMYK
values and a variation increment.  The smaller the increment, the closer to the original CMYK value
all the swatches will be. We recommend a increment of 2 or 3 when focusing in on specific CMYK
values.

Tip! When typing in specific CMYK values, we recommend setting K to 0 to get more vibrant swatches.

Note: Be sure to switch the Size/Type back to Universal/Custom Type 5 via the Control Panel before sending
another print job.

9.2 Color/Alignment Calibration

Color calibration occurs automatically every 500 pages, when a new cartridge or ITU is installed, 
if power saver has been on for more than 8 hours and at other points if one of several internal
parameters has exceeded a threshold.   You will see the Calibrating... notice on the printers control
panel when the calibration is taking place.  This calibration is used for color accuracy and pixel
(print head) alignment.  See Section 9.3 for more information on Print Head Alignment.

You can force the printer to perform this calibration using these instructions.

Press Menu on the Printers Control Panel - Select Settings - Select Quality Menu - Select Color
Adjust (last item on list). The printer will calibrate for several minutes.

9.3 Print Head Alignment

Pixel shifting can be caused by a misaligned print cartridge. This usually occurs after a new 
cartridge is installed. Try the following:

A. First do an auto alignment from the standard printer control panel. Press Menu - Select Settings
- Select Quality Menu - Color Adjust (last item on list). The printer will calibrate for several 
minutes.

B. Perform a manual alignment for the specific color that is out of alignment (usually the same as
the last replaced cartridge) from the Diagnostic menu.

1. On the printer's control panel, set the default source to Tray 1. Press Menu - Select Paper
Menu - Select Default Source - Select Tray 1.
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2. Open the Toner door to disengage the feeder path switch so the paper feeds out the top of
the printer.

3. Turn off the printer.

4. Access the diagnostic menu by holding the Right and Bottom arrow buttons on the control
panel while switching on the unit.

5. Select the Alignment Menu - Select the Color you want to Align - Select „Quick Test“

6. A two page test pattern/worksheet will print.

7. The test pattern is divided into 4 areas: Skew, Top Margin, Left Margin and Right Margin.
Use the lines and Boxes in areas A, B, C, and D, to calculate each value. Write down the
value that corresponds with Black to Color line which is the straightest. When you are 
finished go back to the printer. 

A & B C & D
3
2
1

Use the value closest
to the straight line

12

6

0
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8. To Adjust the Top Margin, Left Margin and Right Margin - Select the Alignment Menu -
Choose the Color you want to Align - Select each area on the menu. A value will be dis-
played. Press the right or the left arrow to adjust the value positively or negatively. Press the
check button to set the value. Some calculated values from the worksheet may not have
changed. If this is the case there is no need to enter this area and set the value again.

9. The skew must be adjusted by physically turning a wheel above the color cartridge you are 
currently aligning. The skew wheel has a plastic cover over it that must be removed in order
to adjust it. If you have trouble removing the cover use a flat screwdriver. You do not need
to adjust this if A and B values are within +/- 1 of each other.

10. Turn the wheel the number of clicks specified in the worksheet in the direction specified in
the worksheet.

11. Reprint the Quick Test to verify the values entered have affected the printer alignment.

12. When you are finished, restart the printer and set the default source back to MP Feeder.
Press Menu - Select Paper Menu - Select Default Source - Select MP Feeder.

9.4 Cut Alignment/Stretch Factor

If printed output is longer or stretched so that the size does not match the size of the file on screen,
cuts can be offset. The cut offset may only be noticeable with longer page lengths and cuts that have
a very small bleed tolerance.  The fuser pulls the paper during printing. This causes the image to
stretch which affects the height or width of the label depending on the orientation. The stretch can
be eliminated by doing a one time calibration.  Follow these instructions:

1. Open the Status Monitor - Start - All Programs - PTPrint - Status Monitor. 

2. Select the Options tab. 

3. Click the Print Calibration button under the Stretch Calibration section.  Click the arrow on the
upper right section of the Advanced section to reveal the Stretch Calibration if it is hidden.
(Continuous paper should be loaded before clicking Print) 
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4. The following calibration print will print to the Printer. 

5. Measure the lines on the calibration print. Enter  the letter below the line which measures 
closest to 10.00 inches.  (Each line differs in length by .01 inch)

6. Click Set. 

In most cases, performing this calibration once will be sufficient.  However, it may be necessary to
run the calibration again if the fuser is replaced. 

A  B  C  D  E  F  G  H  I     

Measure the lines to the left.

Circle the letter below 
the line which measures 
closest to 10.00 inches.  

(Each line differs in length by .01 inch)

Stretch Factor 
Calibration Print

J   K  L  M  N 

 

O

Tip: Use a clear acrylic

ruler to measure the lines. 
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9.5 Stop/Cut Button

Press the Stop/Cut button located on top of the cutter if you need to quickly stop a job.  Do not use
this method for non-emergencies since it will deposit a large amount of toner on the ITU that will be
cleaned and placed in the waste toner bin.   Repeated use will cause toner build up on the cleaning
mechanism and wear on the ITU belt.  For non-emergencies, cancel the job using the control panel
on the printer.  

In order to continue printing you will need to cancel the job in the printer’s internal memory.  
Follow the prompts on the control panel to cancel the job.  The control panel will display “Load MP
Feeder Universal“ and ask you to cancel “your file name“ or “Continue".  Use the arrow button to
scroll through menu and the check button to select “Cancel“.

Finally, reset the printer by turning it off and on again using the power switch.

9.6 Error Messages

Rip Software Service 900. This error can appear on the printer LCD Control Panel panel after the
system is stopped in the middle of job using the Stop/Cut button.  Turn off the printer and turn it
back on again to clear the error.

The printer takes a long time to start printing / Engine warming appears on the control panel
(More than 5 minutes). 

• Larger files will take longer to start printing.

• A slower network will cause a delayed print.  Try connecting directly to PC with crossover 
cable or reevaluate cabling from computer to CX1000e.

• Change the IP address of the printer or look for any IP address conflicts on the network.

The header (leader) or footer (trailer) is longer than expected. Change the header/footer length
via the Option tab/button in the Status Monitor.  The minimum footer in all cases is 3 feet.  This can
not be made shorter.

Figure 9-1.

Stop 

Press to 

Cut 

� 

Stop/Cut Button
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The printed colors do not match the screen. The colors of the label shown in PTPrint may not
match the original design program, other print programs or the printed output of the CX1000e.
There are no ICC profiles available to make colors shown in PTPrint match the printed output or
other programs.  The colors shown on screen will have no effect on the printers ability to print 
specific CMYK values or Pantone Matched CMYK values.

Default Settings NOT set. This error appears before printing or when the status monitor is
opened.  Specific settings will be listed below the error message.  This means that default settings
were changed via the printer control panel or through the print settings window before printing.
The message is a warning that the settings do not match defaults.  If you do not change the settings
back to their original values, unexpected errors may occur.  Contact tech support if you have trouble
restoring the defaults.

9.7 Replacing the Fuser 

1. Pull the tensioner forward until you are able to flip
the housing back out of the way of the printer doors.

2. Open both the upper right and the lower right 
access doors.

Warning: The fuser assembly may be hot. Let it cool before
continuing.

3. Pull down the green latches. They slide toward the
center to release the fuser. 

4. Pull the fuser out, and set it on a clean, flat surface.

5. Insert a new fuser into the printer.

6. Slide the latches out, and then pull up to refasten them.

7. Close the doors.

Figure 9-3.

Figure 9-2.
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9.8 Replacing the Image Transfer Unit

1. Turn the printer off. Open the front cover.

2. Remove all the print cartridges. 
a. Pull up slightly on the cartridge handhold.
b. Pull the cartridge straight out and use the handle to lift it off the guides.
c. Place the cartridges on a clean, flat surface out of direct light.

Figure 9-4.

Figure 9-5.
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3. Remove the image transfer unit.
a. Raise the lever to unlock the image transfer unit.

b. Pull down on the handle.

c. Slide the image transfer unit out and place it on a clean, flat surface. 

Caution: Do not touch the transfer belt. Touching the belt will damage the image transfer unit.

Figure 9-6.

Figure 9-7.

Figure 9-8.
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4. Insert a new image transfer unit back into the printer.
a. Align the guides with the insertion grooves and gently slide the unit in.

b. Rotate the handle up, and push gently to lock the unit in place.

c. Lower the lever to lock the image transfer unit into place.

5. Close the printer door.

6. Turn the printer on. The printer returns to a Ready state. 

9.9 Technical Support.

If you have difficulties operating your CX1000e, the following additional resources are available.   

• Primera Knowledge Base  www.primera.com/kb

• Email Support  sales@primera.eu

• Phone Support  +49 (0)611 92777-0 (Mon - Thu 9 a.m. - 5 p.m, Fri 9 a.m. - 3 p.m. CET)   

Figure 9-9.

Figure 9-10.

http://www.primera.com/kb
mailto:sales@primera.eu
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Print Speed: 83mm/second; 5 meters/minute

Print Method: Color laser

Display: 4-line, 160 x 64 pixel, backlit gray-scale display

Print Processor: 800/133 MHz

Media Width: 216mm

Print Width: 210mm

Print Length: Up to 152 meters per 203mm roll of self-adhesive label stock 
(includes face sheet, adhesive and liner)

Substrate Types: Pre-die cut self-adhesive paper and synthetic label stock

Printing quality modes: 1200 dpi x 600 dpi, 1200 dpi x 1200 dpi, 2400 x 600 dpi
 
Ink supplies: CMYK 4-color printing  (Cyan, Magenta, Yellow, Black)

15,000 page extra high yield cartridges (Rated according to ISO/IEC 19798 
guidelines)

Software: PTPrint™ 8.0 Software for Windows®, easy to use graphical user interface, 
Primera Color System, Pantone® 

Input System: Input roll maximum diameter: 203mm (8“)
Core inside diameter: 76mm (3“)
Automatic paper feed

Output System: Output roll maximum diameter: 203mm (8“)
Core inside diameter: 76mm (3“)

Maximum output 
roll weight: 20.4 kg (45 lbs.)

Operating System: Windows® XP/Vista/7 (32-bit and 64-bit)

Power: Rewinder: External Switching 100-240 VAC, 50/60Hz, 
Output: 60 watts,+12Vdc, 5A  limited power source (LPS)
Unwinder: External Switching 100-240 VAC, 50/60Hz, 
Output: 60 watts,+12Vdc,5A  limited power source (LPS)
Printer:  110-127VAC, 50/60Hz, 7.5A (675W Printing, 25W Power Saver)  
-- or --
220-240VAC, 50/60Hz, 3.5A (675W Printing, 25W Power Saver)
Cutter: +12Vdc, 5A  limited power source (LPS) from Unwinder.

System 
Recommendations: Intel® Pentium®-based PC or compatible, 2 GHz processor or 

higher, 2GB RAM or higher, 10 GB or more free hard drive space, 
VGA video display of 1024x768 or higher, USB 2.0

Section 10: Specifications 

http://primera.eu/en/specifications/cx1000e.html
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Dimensions: 150cm W x 71.6cm H x 54.6cm D (58.9“W x 28.2“H x 21.5“D)

Weight: Approximately 91 kg (200 lbs.)

Operating Environment: Temperature: 20° to 23°C (68 to 74°F)
Humidity: 40 to 55% relative humidity
Altitude: 0 – 2000 meters (6,560 feet)

Certifications: CSA, ICES Class A, FCC Class A, UL 60950-1, IEC 60320-1, CE Class A,
CB IEC 60950-1, IEC 60825-1, GS (TÜV), C-tick mark Class A

Warranty: One year parts and labor

Options: Extended warranty 
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